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Module: Energy Resources & Light Pollution Mitigation 

Topic: Light Pollution Mapping 

Lesson Plan – Light Pollution mapping   

Duration: 2 lessons of 45 minutes  

Short Description 

of the Lesson 

Students will gain an understanding of what light pollution is, how it impacts our 

environment, how we map light pollution and we can work with real data in order to 

identify changes as well as on how we can reduce and apply mitigation measures. 

Learning Goals 

• Describe different types of light pollution 

• To recognise some sources of light pollution and describe how these affect how 

we see stars in the night sky 

• To conduct an experiment to find out how artificial light can be directed and 

which materials and shapes would help do this 

Green 

Competences 

Linked 

• Knows that when human demand for resources is driven by greed, indifference 

and unfettered individualism, this has negative consequences for the 

environment. 

• Knows which aspects of personal lifestyle have higher impacts on sustainability 

and require adapting. 

• Can bring personal choices and action in line with sustainability values and 

principles. 

• Listens actively and shows empathy when collaborating with others to frame 

current and potential sustainability challenges. 

Target Group Secondary school students aged 12-18 years old 

Educational 

Approach  

Inquiry-based scenario 

Link to School 

Curricula (if 

applicable)  

Environmental education, Geography, Physics (Energy) 

Facility/ 

Equipment 

• Classroom 

• Internet access 

• Projector 

• White board 

• Personal computers 

 

Tools/ Materials 
• Sticky notes 

Main Tasks  

Introduction to light pollution mapping and topics………….. 
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Task 1: Light pollution monitoring and mapping (10 minutes) 

You can ask students if we can see Light Pollution from space! Is this 

possible and how?  

 

Now let’s use an online Geographic Information Systems platform to 

monitor light pollution at a global scale! 

You can use the Dark Site Finder app in the following link: 

 

Dark Site Finder 

 

Let the students to navigate on the map and identify different areas of 

increased light pollution. 

Discuss with the students their thoughts and if any correlation exists 

between the sites of increased light pollution and the number of people 

live there (big cities, industrial areas, roads etc.). This map is real, 

however, is a little bit enhanced in terms of the light pollution 

distribution, spread and colours. What is next?  

TO WORK WITH REAL DATA AND DIGITAL TOOLS! LET’S DO THIS!  

 

Task 3: Light pollution in our area/city/region using real data and tools (30 minutes) 

3.1 Introduction 

Video: How one NASA image tells dozens of stories (5 min) 

https://youtu.be/ZYGd-llxHJE 

3.2 Case study  - Implementation phase 

see Annex I with all technical guidelines step by step (25 minutes) 

3.3 Discussion - Explanation based on evidence (10 minutes) 

Encourage your students to provide correct explanations for the topic(s) 

investigated. Describe ways and they can use to this end and give them 

directions how to discover them. You can start a conversation related to 

the results explanation by asking: 

• What do you think that the minimum and maximum values 

indicate? 

• Negative values point out a potential Light Pollution decrease? 

On the contrary, increased positive values highlight a potential Light 

Pollution increase between 2012 and 2021? 

3.4 Reflection - Communicate explanation (Homework) 

Help the students to get familiarized and to become efficient in scientific 

writing or poster presentation. 

Ask from students to write a short report by incorporating the scope of 

this Activity (the objective?), the data and the tools they used, what 

methodology (QGIS tools) and to present their results in the form of 

maps (images) by reporting the differences of Light Pollution levels 

between 2012 and 2021. 

https://darksitefinder.com/maps/world.html#7/40.591/22.634
https://youtu.be/ZYGd-llxHJE
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They can also report all potential adjustments they made (clipping areas) 

or any future research they want to consider (add Light Pollution data 

for year 2018, 2020 etc.). 

The report outline could be in the form of: Introduction, Study area and 

Data used, Methodology (tools), Results and Discussion. 

-------------------------------------------------------------------------------- 
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ANNEXES 
 

QGIS TUTORIAL FOR LIGHT POLLUTION ACTIVITY 

 

   

Title: Light Pollution hunters   

In order to better understand what type of data we will use and how we “translate” or model 

the Earth surface and processes, we have to discuss about spatial data structures (type of data 

and how spatial information is stored, data types etc.) 

A short explanation: 

https://www.youtube.com/watch?v=HwVFvHwuYJo 

Vector and Raster data: 
Some useful examples on how we can model a river, a mark on the map or an area using vector and 

raster data structures! 

 

 

 

 

 

 

 

 

 

 

 

Support Material for Vector and Raster data: https://gisgeography.com/spatial-data-types-vector-

raster/ 

WHY THIS IS IMPORTANT? 

In order to understand spatial data structures, models’ data inputs, data volume, spatial resolution, 

scale and other relevant terms and definitions. 

 

 

An example 

Vector data 

(Lines, Points, 

Polygons) 

Raster data (as 

Lines, Points, 

Polygons) 

https://www.youtube.com/watch?v=HwVFvHwuYJo
https://pediaa.com/what-is-the-difference-between-raster-and-vector-data/
https://gisgeography.com/spatial-data-types-vector-raster/
https://gisgeography.com/spatial-data-types-vector-raster/
http://www.eo4geo.eu/training/urban-heat-islands-basic-gis-knowledge-vector-and-raster-data/
https://www.azavea.com/blog/2014/08/21/summer-of-maps-raster-versus-vector-visualization/vector-raster/
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Explanation about raster data and satellite images: 

https://desktop.arcgis.com/en/arcmap/10.3/manage-data/raster-and-images/what-is-raster-
data.htm 

 

 

 

 

 

 

 

 

How do we manage and process this type of data? 

Using Geographic Information Systems (GIS) and specific GIS-based applications and platforms! 

GIS definitions: https://www.esri.com/en-us/what-is-gis/overview 

GIS software and platforms (see QGIS): 
https://en.wikipedia.org/wiki/List_of_geographic_information_systems_software 

 

The selected resource (e.g., a simulation, an experiment, an animation, a graph, or other exhibit of 

similar nature) must provide students with an opportunity to collect evidence addressing the scientific 

questions presented in previous stages through direct or indirect observation.  

Students can work in groups of two where each member of the group is responsible for:  

1) Data collection (maps, spatial data etc.) and reporting 

2) Data interpretation and analysis 

 

Before we begin, students have to download and install QGIS platform! 

QGIS Platform Download (version 3.18.1, file QGIS-OSGeo4W-3.18.1-1-Setup-x86.exe) 

https://download.qgis.org/downloads/windows/3/3.18/ 

Download Light Pollution data  

https://www.lightpollutionmap.info/#zoom=8.15&lat=38.2410&lon=23.9360&layers=B0FFFFFFFFFFTFFFFF
FFF 
 

Figure 4: Indicative example of a raster dataset (i.e satellite image) expressed as a grid of 

multiple cells with different (or the same) pixel/cell values, for example, light pollution 

density 

https://desktop.arcgis.com/en/arcmap/10.3/manage-data/raster-and-images/what-is-raster-data.htm
https://desktop.arcgis.com/en/arcmap/10.3/manage-data/raster-and-images/what-is-raster-data.htm
https://www.esri.com/en-us/what-is-gis/overview
https://en.wikipedia.org/wiki/List_of_geographic_information_systems_software
https://download.qgis.org/downloads/windows/3/3.18/QGIS-OSGeo4W-3.18.1-1-Setup-x86.exe
https://download.qgis.org/downloads/windows/3/3.18/
https://www.lightpollutionmap.info/%23zoom=8.15&lat=38.2410&lon=23.9360&layers=B0FFFFFFFFFFTFFFFFFFF
https://www.lightpollutionmap.info/%23zoom=8.15&lat=38.2410&lon=23.9360&layers=B0FFFFFFFFFFTFFFFFFFF
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1. Light Pollution Map – Download Data 

 

The first step of the activity is to navigate on an online light pollution mapping Web-GIS platform and 

download data (raster data). To succeed this, visit the following link: 

 

Light Pollution Web-GIS platform 

You can see the platform’s interface below! 

 

In the platform you can see the light pollution levels at global scale. In particular, you see the radiance 

levels at night, as seen from the satellites.  

On the right corner you may select different light pollution maps per year (i.e. from 2012 - 2021), you 

can change the basemap layer, change the transparency level, see the map legend or even to save 

different locations around the world. 

 

 

 

 

 

 

 

Select year based on the VIIRS 

satellite mission data 

See map’s legend, change basemap 

or select point features with actual 

measurements. 

https://www.lightpollutionmap.info/#zoom=2.63&lat=43.8186&lon=31.3948&layers=B0FFFFFFFTFFFFFFFFFFF
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While you select one of the VIIRS mission rasters (maps), you can zoom in wherever you want and you 

can left-click a specific area (pixel). Then a graph appears showing the temporal changes on Light 

Pollution levels from 2012 – 2021, the exact coordinates and the elevation as shown below. 

 

In case you want to download data or see further information and statistics at a country level, you can 

use the toolbar on the left as shown below: 

 

 

 

 

 

 

 

In order to download data, you select the tools icon (bottom right) and then you click on the circle to 

select a specific area based on the circle’s radius as shown below: 
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While you select the circle’s radium you left click and a pop-up window appears with all descriptive 

characteristics for this area and the option to download the data in GeoTiff format (bottom right corner). 

Repeat the above mentioned process for both the VIIRS 2014 AND VIIRS 2021 images using always the 

same circles center and radius. 

NEXT STEP CONSISTS OF LOADING AND PROCESSING THE IMAGES IN QGIS PLATFORM! 

 

2. QGIS Interface 

 

Some technical guidelines considering the tools (QGIS Platform) we will use during this Activity! 

Load data: In general, data can be loaded in four ways. The first way (see Figure below, selection 2) is to 

use the Layer > Add Layer menu and select the appropriate type of data you wish to load. The second 

way (Figure-selection 1) is to open the Browser panel, navigate to the data you wish to load, and then 

drag the data on to the map display, or on to the Layers panel. The third way (Figure -selection 6) to 

load data is to enable the Manage Layers toolbar and click on the button representing the data type you 

wish to load. The fourth way is to locate the data in QGIS Browser, drag to the data, and drop it onto the 

QGIS Desktop Map Display or Layers panel (Source: https://www.gislounge.com/loading-data-

mastering-qgis/). 

 

 

 

Step 1:  Install the Plugins needed to run the activity (QuickMapServices) 

https://www.gislounge.com/loading-data-mastering-qgis/
https://www.gislounge.com/loading-data-mastering-qgis/
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To begin using plugins, you need to know how to download, install and activate them (Figure 6). To do 

this, you will learn how to use the Plugin Installer and Plugin Manager. But what a Plugin is? 

Plugins in QGIS add useful features to the software. Plugins are written by QGIS developers and other 

independent users who want to extend the core functionality of the software. These plugins are made 

available in QGIS for all the users (Source: QGIS Tutorials). 

You 

can 

load 

the 

Basemap using the Main Toolbar on top: Web > quickMapServices > OSM > OSM Standard. 

The result is shown below! 

 

 

 

 

1. Click on Plugins on the Main Toolbar 

2. Select Manage and Install Plugins 

3. All Plugins 

4. Type “quickmapservices” 

5. Select it 

6. Click “Install Plugin” 

https://www.qgistutorials.com/en/docs/using_plugins.html
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Step 2 - Based on the above-mentioned instructions you can start with:   

1. During the first step of the Activity, load the Light Pollution files you have downloaded (VIIRS 2012 

and 2021) on the QGIS platform. 

2. Use the Main toolbar (top of the screen) -> Layers -> Raster Layer -> Navigate to your folder and 

select viirs_npp_201200.tif and viirs_npp_202100.tif 

The results on the map will look like this, having only black and white colors for both images: 
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3. Change layout colors using Layer Properties (double-click on the .tif image you have loaded) -> 

Symbology -> Single-band Pseudocolor -> Classify. See image below! 

 

 

4. Identify areas of increased light pollution (blue and yellow colors) or the differences between 2012 

and 2021 by checking and un-checking each map on the Layers panel. Alternatively, you can use the 

Identify 

button 

1. Double-click 

2. Symbology 

3. Select Singleband Pseudocolor 

4. Press Classify 

5. Optionally, you can change 
coloramp 
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identify button (see the image above) in order to extract the exact light pollution values (in terms of 

illumination levels). 

 

BUT HOW WE QUANTIFY THE DIFFERENCES AND THE DIFFERENCES TO LIGHT 
POLLUTION LEVELS AMONG DIFFERENT YEARS??? 

 

Step 3 – Quantify changes of Light Pollution levels 

We have to simply compare each pixel’s value from viirs_npp_201200.tif and viirs_npp_202100.tif 

and we have to do this for all pixels! To succeed that, we need a specific tool called “Raster 

Calculator”.  Using this tools we can run through different math operations and conditional 

statements between different rasters (images). 

A simplified measure to compare pixels’ values is by subtracting the pixel values of 

viirs_npp_202100.tif  from viirs_npp_201200.tif!  

Hence, open Raster Calculator via the main toolbar > Raster > Raster Calculator and type: 

"viirs_npp_202100@1" - "viirs_npp_201200@1" 

 

Save your file as ‘Final’ as you see below! 
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You can change the map colors as previously by selecting the properties of the Layer Final > 
Symbology > Single band pseudocolor. The results is shown on the last map. 
 

Inspect your results, the colors and the min-max values! 

 

References: 

ESRI Overview: What is GIS 

 

 

 

1. Save layer to your folder as Final.tif 

2. Type the expression 

https://www.esri.com/en-us/what-is-gis/overview

